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		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 3 of 5.: 

		TRAVELER (NAME). Line 2 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES.: 

		EVENT DESCRIPTION: 

		TRAVELER (NAME). Line 3 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE). Line 4 of 5.: 

		TRAVELER (NAME). Line 4 of 5.: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED AMOUNT: 

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED CHECK IN-KIND: 0

		BENEFITS ACCEPTED CHECK: 0

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED DESCRIPTION: 

		BENEFITS ACCEPTED SOURCE: 

		TRAVEL DATES. : 

		LOCATION: 

		EVENT DATES. : 

		EVENT SPONSOR : 

		EVENT DESCRIPTION: 

		TRAVELER (TITLE).  Line 5 of 5.: 

		TRAVELER (NAME). Line 5 of 5.: 

		BENEFITS ACCEPTED SOURCE: 










SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
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1 
OF PAGES 


20 
This report implements 31 U S C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1 . . . 


REPORTING DEPARTMENT OR AGENCY 


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


fl) 
Relations sponsored by Asia-Pacific w 


Secretary ..J Forum. 0.. 


� ····································································· ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 
SSG Samuel Winter Trade Show, Diving DEMA Show 


TITLE SPONSOR 


DiveLab Inc 
TWI Student DATES: 11 /14/18-11 /16/18 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) 


2018 I '
APRIL 1 - SEPTEMBER 30 (Year) 


I I NEGATIVE REPORT 


LOCATION AND 


TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ····················································· 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 
Las Vegas, NV Dive Lab Inc. 


DATES 


11/14/18-11/16/18 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X . ................ ..120 ....................................... ............. ............... 


Air Transportation X X $825 
Meals 120 


Hotel X 76.54 


Air Transportation X 601.60 


Meals X 130.00 


Show Registration X 155.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


US Army Human Resources Command
x







2 20


US Army Human Resources Command X







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE 


3 


OF PAGES 


20 


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


USARMY(TWI)  Human Resources Command 


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


en 
Relations sponsored by Asia-Pacific w 


Secretary ..J Forum. D.. 


::i!!: 
..................................................................... ........................................................................ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Willie L. Franklin NDTA Fall Meeting 


Student, TWI Washington DC 


TITLE SPONSOR 


Student, TWI Brock Carlson 


DATES: 10/21-10/27/18 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD 


I OCTOBER 1 - MARCH 31 (Year) 


2019 I I
APRIL 1 - SEPTEMBER 10 (Year) 


I I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 
National Defense 


Washington, DC 
Transportation 


Association 
DATES 


10/21-10/27/18 


LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X . ................ .J.?9 ....................................... ············· ............... 


Air Transportation X X $825 
Meals 


120 


Hotel X $2200 


Air Transport X $841 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


X







US Army Human Resources Command X 2019


4 20







US Army Human Resources Command X 2019


5 20







US Army Human Resources Command X 2019


6 20







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE OF PAGES 


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority For definition and policies, see 41 CFR part 304-1 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command 


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith Conference on Asia-Pacific 
U) Relations sponsored by Asia-Pacific w Secretary ..J Forum. D.. 


:E 
..................................................................... ········································································ 


� Joyce Smith Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Willie L. Franklin RAMP 1 Training 
Student, Training with Industry FedEx Express 


TITLE SPONSOR 


Student, Training with Industry FedEx Express, Memphis, TN 


DATES: 17-23 Feb 2019
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD 


I OCTOBER 1 - MARCH 31 (Year) 


2019 I '
APRIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. . .................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 
FedEx Express 


Atlanta, Georgia 
FedEx Corporation 


17-23 Feb 2019


DATES 


17-23 Feb 2019
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X . ................ ..120 
....................................... ••o•o•••••oH ••••u•••• • •• • • 


Air Transportation X X $825 
Meals 120 


Hotel X $708.30 


Air Transport X $585.24 


STANDARD FORM 326 (2-98) 
Prescribed by GSNOGE (41 CFR 301-1) 


X


7 20







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE OF PAGES 


20 


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command


TRAVELER EVENT 
(Nameflitle) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


rn Relations sponsored by Asia-Pacific w Secretary ...I Forum. 
····································································· ........................................................................ 


� Joyce Smith Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Michael Becker 2019 Certified Dealer Instructor 
Demonstrator/Instructor (CDI) Conference
TITLE SPONSOR 


Caterpillar 
TWI Student DATES: 2/10/19 - 2/15/19 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD 


I 
OCTOBER 1 - MARCH 31 (Year) 


February 10, 2019 I I
APRIL 1 - SEPTEMBER 30 (Year) 


I 
February 15, 2019 I NEGATIVE REPORT NIA 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ····················································· 


San Francisco, CA Asia-Pacific Forum
8/11-13/93 Pacific Rim Assoc.


LOCATION 


Tinaja Hills, AZ 
DATES 


2/10/19 - 2/15/19 Caterpillar 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X .. ............... ..120....................................... ............. · · ············· 


Air Transportation X X $825 
Meals 


120 


Hotel X 575.00 


Meals X 120.11 


Airfare X 753.01 


STANDARD FORM 326 (2-98) 
Prescribed by GSNOGE (41 CFR 301-1) 


xxxxxxxxxxxx xxxxxxxxxxxxxxxxxx


8







US Army Human Resources Command X 2019


9 20







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE OF PAGES 


20 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command 


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


U) 
Relations sponsored by Asia-Pacific w 


Secretary ..J 
Forum. a. 


::E: 
···························· .. ,, ..................................... ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Conference on Historical 
Kevin S. Malmquist Monuments and Modern Society 
TITLE SPONSOR 


Shanghai University 
Student DATES: 29 Nov - 3 Dec 2018 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


I OCTOBER 1 - MARCH 31 (Year) I r I 


REPORTING PERIOD 
PRIL 1 - SEPTEMBER 30 (Year) 


 
I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
············································· ····················································· 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


Shanghai, China 
DATES 


29 Nov - 3 Dec 2018 Shanghai University 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X . .................. J.:?.9 ······································· ............ .............. 


Air Transportation X X $825 
Meals 


120 


Hotel X 225.00 


Meals X 80.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


10


X 2019







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE 


11 
OF PAGES 


20 
This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


(/) Relations sponsored by Asia-Pacific w Secretary ..J Forum. a.. 
::E 


..................................................................... ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Nadine Schumacher A USA-Conference 
TITLE SPONSOR 


VT Miltope 
Training With Industry Student DATES: 10/4-11/2018 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD 


I
OCTOBER 1 - MARCH 31 


(Year)  209


I I
APRIL 1 - SEPTEMBER 10 (Year) 


I I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


Washington D.C 
10/4-11/2018 
DATES 


VT Miltope, 


10/4-11/2018 American Airlines 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X . .................. 120·······························"''''" ............. ............... 


Air Transportation X X $825 
Meals 


120 


Flight-American 
Airline X 497.00 


Hotel-Marriot 
X Rennaisance 1,027.39 


Meal-Partners 
Lunch est value X 20.00 


Bag Fee waiver X 30.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


X 2019







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE 


12
OF PAGES 


20
This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


en 
Relations sponsored by Asia-Pacific w 


Secretary ...J 
ll. Forum. 


·· ····················· ······ ·•·· .. ···"····························· ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


Nadine Schumacher Closure of Longmont Office 
TITLE SPONSOR 


VT Miltope 
TWI Student DATES: 12/10/18-12/14/18 


NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 


(Year) 2018 
I '


APRIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 


TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


Longmont, CO 
OATES 


12/10/18-12/14/18 VT Miltope, Delta Airlines 
LOCATION 


OATES 


LOCATION 


OATES 


LOCATION 


OATES 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 


Air Transportation X 825 
Meals X 120 ....................................... ............. ··············· .......................... 


Air Transportation X X $825 
Meals 


120 


Flight-Delta Air 
Lines X 949.60 


Hotel-Marriot 
X Fairfield 542.62 


National Car 
Rental w/gas X 291.10 


Bag fee waiver X 60.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


X 2019







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA 
PAGE 
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OF PAGES 


20
This report implements 31 U S C  1353 It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1 . . . 


REPORTING DEPARTMENT OR AGENCY 


TRAVELER EVENT 
(Namerritle) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


en 
Relations sponsored by Asia-Pacific w 


.J Secretary 
Forum. ·······························································"·"· ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 


MSG Gordon D. Reid HR Certification Prep Course 
TITLE SPONSOR 


HRCI 


TWI DATES: 7 Sep - 7 Dec 2018 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) 


I '
APRIL 1 - SEPTEMBER 10 (Year) l I NEGATIVE REPORT 


LOCATION AND 
TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ·····················································


San Francisco, CA Asia-Pacific Forum
8/11-13/93 Pacific Rim Assoc.


LOCATION 


Online Course 
DATES 


Human Resources 


7 Sep - 7 Dec 2018 Certification Institute 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 
DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X 120 ······································· ............ , ............... .......................... 


Air Transportation X X $825 
Meals


120 


Coursew/ 
Materials X 434.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


US Army Human Resources Command
X 2019







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE 
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OF PAGES 


20
This report implements 31 U S C  1353 It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority For definition and policies see 41 CFR part 304-1 . . .  
REPORTING DEPARTMENT OR AGENCY 


TRAVELER EVENT 
(Namerritle) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


en 
Relations sponsored by Asia-Pacific w 


.J Secretary 
D.. Forum. 
:!: 


····································································· ········································································ 


� Joyce Smith Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 
Mariah Perez 


International Chiefs of Police 
Annual Conference 2018 


TITLE SPONSOR 


lnernational Chiefs of Police 
Army Fellow to IACP DATES: 1 0/06-1 0/09 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) 


2018 I '
APRIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 


TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


Orlando, FL 
International Chiefs of 


DATES Police 


10/05 -10/10 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X 120 ....................................... ............ ............... .......................... 


Air Transportation X X $825 
Meals 


120 


Hotel X 517.50 


Air X 252.42 


Taxi 
Transportation X 185.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSNOGE (41 CFR 301-1) 


xxxxxxxxxxxx 2019US Army Human Resources Command X


2018 2018







15 20


X 2019







16 20


X 2019







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE 
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OF PAGES 


20
This report implements 31 U S C  1353 It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority For definition and policies see 41 CFR part 304-1 . . 
REPORTING DEPARTMENT OR AGENCY 


US Army Human Resources Command


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


rn 
Relations sponsored by Asia-Pacific w 


..I Secretary 
Forum. 


••• •••••••••• •••••••••••••••• •••••••••••u••••••••••• •••••••••••••••• ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 
Chad R. Fox On-line course provided by SANS 


Institute. 


TITLE SPONSOR 
Training With Industry (TWI) Siemens Corporation 


OATES: 1 Nov 18 - 3 Jan 19 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) 


1 Nov 18 - 3 Jan 19 I '
APRIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 


TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
............................................. ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 
Princeton, NJ Siemens Corporation 


OATES 


1 Nov 18 - 3 Jan 19 
LOCATION 


OATES 


LOCATION 


OATES 


LOCATION 


OATES 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X 120 ....................................... ............ . ............ ... .......................... 


Air Transportation X X $825 
Meals 


120 


Training Course X 
5,394.44 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 2019X







US Army Human Resources Command X 2019


18 20







SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES 


This report implements 31 U S C  1353 It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority. For definition and policies, see 41 CFR part 304-1 . . . 


REPORTING DEPARTMENT OR AGENCY 


TRAVELER EVENT 
(Name/Title) DESCRIPTION/SPONSOR/ DATES 


John Smith 
Conference on Asia-Pacific 


rn 
Relations sponsored by Asia-Pacific w 


.J Secretary 
Forum. 


......................................................... ............ ········································································ 


� Joyce Smith 
Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific w Spouse of Secretary 
Forum. 


NAME DESCRIPTION 
To attend and teach training on 


Marc Ladson Maintenance requirements of 
equipment at Haile Goldmine 


TITLE SPONSOR 


Jeff Payne 
CW3, ODTWI DATES: 5Nov18 - 8 Nov18 
NAME DESCRIPTION 


TITLE SPONSOR 


DATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 
NAME DESCRIPTION 


TITLE SPONSOR 


OATES: 


AUTHORIZED FOR LOCAL REPRODUCTION 


REPORTING PERIOD I OCTOBER 1 - MARCH 31 (Year) I '
APRIL 1 - SEPTEMBER 10 (Year) I I NEGATIVE REPORT 


LOCATION AND 


TRAVEL DATES SOURCE 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 
···································"·"····· ..................................................... 


San Francisco, CA Asia-Pacific Forum 
8/11-13/93 Pacific Rim Assoc. 


LOCATION 


Kershaw, SC 
DATES 


Caterpillar 
Conditions Monitoring 


5NOV18-8NOV18 Team 
LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X 825 
Meals X .. ................. �.?9 •••••••••••••••••••••••••••••u• • •• •••• ............. · ·· · ···········


Air Transportation X X $825 
Meals 


120 


Hotel X 393.68 


Ground 
X Transportation 267.25 


Meals X 108.34 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1) 


US Army Human Resources Command X 2019


19 20







PAGE OF PAGES 
SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval No.: 0416-GSA-SA 


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filed when travel or travel expenses are accepted under other authority. For defintions and policies, see 41 CFR part 304-1. 
REPORTING DEPARTMENT OR AGENCY 


TRAVELER 


(Name/Title) 


U) John Smith 
w Secretary ...J 
ll. 


:iE 
.......................................................................... 


� Joyce Smith 
w Spouse of Secretary 
NAME 


Elizabeth Weaver 
L TC, PhD Student 


TITLE 


NAME 


TITLE 


NAME 


TITLE 


NAME 


TITLE 


EVENT 


DESCRIPTION/SPONSOR/DATES 


Conference on Asia-Pacific Relations 
sponsored by Asia-Pacific Forum. 
8/10- I 3/1993 


....................... ............................. 


Conference on Asia-Pacific Relations 
sponsored by Asia-Pacific Forum. 
8/10-13/1993 


DESCRIPTION 


Instructor for study abroad course 
sponsored by Virginia Tech Geog 


,...,..._....,,....,.. •nT a ,T1n 


SPONSOR 


DATES: 
DESCRIPTION 


SPONSOR 


DATES: 
DESCRIPTION 


SPONSOR 


DATES: 
DESCRIPTION 


SPONSOR 


DATES: 


D 


REPORTING PERIOD 
OCTOBER 1 - MARCH 31 (Year) I r


PRIL 1 - SEPTEMBER 30(Year) I I NEGATIVE REPORT 2019 
LOCATION AND 


TRAVEL DATES 


San Francisco, CA 
8/ll - 13/1993 


............................ 


San Francisco, CA 
8/11 - 13/1993 


LOCATION 


New Zealand 
28DEC18-18JANl9g 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


LOCATION 


DATES 


SOURCE 


Asia-Pacific Forum 
Pacific Rim Assoc . 


.. ................................ 


Asia-Pacific Forum 
Pacific Rim Assoc. 


Virginia Tech 
Department of Geography 


BENEFITS ACCEPTED 


DESCRIPTION CHECK IN-KIND AMOUNT 


Hotel X $280 
Air Transportation X $825 
Meals ·-------····--··$120.X ...... .. . .......................................... ..... 


Air Transportation X $825 
Meals X $120 


Air D ✓ 2,121.63 


AUIP Course D ✓ 4,195.00 


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 304-1) 


US Army Human Resources Command X


X 20 20

















SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
PAGE OF PAGES


REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 





SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

Form Approval.: 0416-GSA-SA

PAGE

OF PAGES

REPORTING DEPARTMENT OR AGENCY

REPORTING PERIOD

OCTOBER 1 - MARCH 31 (Year)

APRIL 1 - SEPTEMBER 30 (Year)

NEGATIVE REPORT

John Smith Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

Joyce Smith Spouse of Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.

AUTHORIZED FOR LOCAL REPRODUCTION

EVENT

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

TRAVELER

(Name/Title)

DESCRIPTION/SPONSOR/ DATES

LOCATION AND  TRAVEL DATES

EXAMPLES

San Francisco, CA 8/11-13/93

San Francisco, CA

8/11-13/93

CHECK

IN-KIND

AMOUNT

Hotel  Air Transportation Meals

Air Transportation Meals

X

X

X  X

X

$280 825 120

$825 120

STANDARD FORM 326 (2-98)

Prescribed by GSA/OGE (41 CFR 301-1)

LOCATION

DATES:

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE 

DESCRIPTION

SPONSOR

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

EVENT

DESCRIPTION/SPONSOR/DATES

LOCATION AND 

TRAVEL DATES

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

CHECK

IN-KIND

AMOUNT

LOCATION

DATES:

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE 

DESCRIPTION

SPONSOR

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

NAME

TITLE

DESCRIPTION

SPONSOR

DATES:

LOCATION

DATES

TRAVELER

(Name/Title)

STANDARD FORM 326 (2-98)
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SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE Form Approval.: 0416-GSA-SA
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REPORTING DEPARTMENT OR AGENCY REPORTING PERIOD


OCTOBER 1 - MARCH 31 (Year) APRIL 1 - SEPTEMBER 30 (Year)
NEGATIVE REPORT


John Smith 
Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


Joyce Smith 
Spouse of Secretary


Conference on Asia-Pacific 
Relations sponsored by Asia-Pacific 
Forum.


Asia-Pacific Forum 
Pacific Rim Assoc.


This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.


AUTHORIZED FOR LOCAL REPRODUCTION


EVENT BENEFITS ACCEPTED
SOURCE DESCRIPTION


TRAVELER 
(Name/Title) DESCRIPTION/SPONSOR/ DATES


LOCATION AND  
TRAVEL DATES


EX
A


M
PL


ES


San Francisco, CA 
8/11-13/93


San Francisco, CA 
8/11-13/93


CHECK IN-KIND AMOUNT


Hotel  
Air Transportation 
Meals


Air Transportation 
Meals


X


X


X 
 


X


X


$280 
825 
120


$825 
120


STANDARD FORM 326 (2-98) 
Prescribed by GSA/OGE (41 CFR 301-1)


LOCATION
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TITLE


DESCRIPTION


SPONSOR


DATES:
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DATES
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DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:
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DATES







EVENT
DESCRIPTION/SPONSOR/DATES


LOCATION AND  
TRAVEL DATES


BENEFITS ACCEPTED
SOURCE DESCRIPTION CHECK IN-KIND AMOUNT


LOCATION


DATES:


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE 


DESCRIPTION


SPONSOR DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


NAME


TITLE


DESCRIPTION


SPONSOR


DATES:


LOCATION


DATES


TRAVELER 
(Name/Title)


STANDARD FORM 326 (2-98) 
 





SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

Form Approval.: 0416-GSA-SA
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OF PAGES

REPORTING DEPARTMENT OR AGENCY

REPORTING PERIOD

OCTOBER 1 - MARCH 31 (Year)

APRIL 1 - SEPTEMBER 30 (Year)

NEGATIVE REPORT

John Smith Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

Joyce Smith Spouse of Secretary

Conference on Asia-Pacific

Relations sponsored by Asia-Pacific

Forum.

Asia-Pacific Forum

Pacific Rim Assoc.

This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.

AUTHORIZED FOR LOCAL REPRODUCTION

EVENT

BENEFITS ACCEPTED

SOURCE

DESCRIPTION

TRAVELER

(Name/Title)

DESCRIPTION/SPONSOR/ DATES

LOCATION AND  TRAVEL DATES

EXAMPLES

San Francisco, CA 8/11-13/93

San Francisco, CA

8/11-13/93

CHECK

IN-KIND

AMOUNT

Hotel  Air Transportation Meals

Air Transportation Meals

X

X

X  X

X

$280 825 120

$825 120

STANDARD FORM 326 (2-98)
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LOCATION
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TRAVELER

(Name/Title)

STANDARD FORM 326 (2-98)

 

		REPORTING DEPARTMENT OR AGENCY: USACE, Chicago District (CELRC)

		REPORTING PERIOD. OCTOBER 1- MARCH 31 (YEAR): 2019
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This report implements 31 U.S.C. 1353. It does not supersede other reports that may have to be filled when travel expenses are accepted under other authority.  For definition and policies, see 41 CFR part 304-1.
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Completing the OGE Form-1353


Saving the Workbook
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Preparing Blank Report Forms for Each Sub-Agency  (if applicable)
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Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2019


Agency Contact:
[Replace with 
Agency Contact 
Name]


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Alan Dunbar   Attorney 
Advisor Conference on Cyber  10/31/2018 Maxwell, AFB Lodging X $60 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $720.33 


Maj USAF 11/1/2018 10/31/2018-
11/01/2018 Vehicle rental X $100.52 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


Jason Finley         Vice 
Chair for 
Undergraduate 
Programs


Illinois State University 
Accreditation Visit 2/20/2019 Normal, IL Mileage X $332.45 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Tolls X $4.00 


MAJ


National Environmental 
Health Science and 
Protection Accreditation 
Council


2/22/2019 02/19/2019-
02/22/2019 Hotel X $188.00 


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


National Guard Bureau
[REPLACE WITH SUB-AGENCY NAME] NEGATIVE 


REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


X


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019


3


LOCATION


TRAVEL DATE(S)


Asia Pacific Forum 
Pacific Rim Foundation 


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


LTC Jocelyn Urgese / Ethics Chief 


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


BENEFIT SOURCE


The Air Force Judge 
Advocate General School 


Foundation


BENEFIT SOURCE


National Environmental 
Health Science and 


Protection Acreditation 
Council (EHAC)


BENEFIT SOURCE


BENEFIT SOURCE





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM






Completing the OGE Form-1353


Saving the Workbook


-


-


-


Preparing Blank Report Forms for Each Sub-Agency  (if applicable)


-


-


-


Completing the General Information


Renaming the Spreadsheet Tabs


-


-


-


-


Instructions for § 1353 Travel Report


Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  


If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).


The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  


Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  


Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).


Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls


Fill in the white-colored cells found below Page, Of Pages, and Year. 


Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.


Filling in Page, Of Pages and  Year


Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  


For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 


Ensure use of standardized acronyms where applicable.


Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 


Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.







-


-


-


-


Filling in Travel Specific Information


Indicating a Negative Report
-


-


Submitting the Report to OGE


Printing Reports for Internal Agency Use and Record Keeping


In Excel 2007
-


-


-


-


-


In Excel 2003
-


-


To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.


Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.


While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.


Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 


On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".


Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”


Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  


In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  


Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.


Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."


Indicating 1353 Travel


Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.


If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.


For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.


Filling in Agency Name, Sub-Component Name, and Contact Information


Indicating Reporting Period







-


-


-


Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.


Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.


Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.







Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission


Semiannual Report of Payment Accepted







Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President







Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency


If your agency is not listed here or if you have questions about the standard acronym for your      







Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC


    







EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP







OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA


                 r agency, please contact OGE at 1353travel@oge.gov







PAGE OF PAGES YEAR


1 1 2019


Agency Contact: CPT Daryl M. Delap


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]


John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825


Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


MAJ Ryan Kenny Fellowship visit to college 3/15/2019 Pennsylvania Air Transportation X $400 


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel X $350 


311th Signal Command 
(Theater)


Carnegie Mellon 
University 3/17/2019 3/15/2019-3/17/2019                            


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


CSM Tracy Barlogio AUSA Conference 10/7/2018 Washington, D.C. Hotel X 852.78


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X 803.05


311th Signal Command 
(Theater) 10/9/2018 10/06/2018-


10/10/2018 Meals X 258.75


TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               


                              


TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              


                           


BENEFIT SOURCE


Carnegie Mellon 
University


BENEFIT SOURCE


AUSA


BENEFIT SOURCE


BENEFIT SOURCE


2


EX


TRAVEL DATE(S)


LOCATION


LOCATION


TRAVEL DATE(S)


1


LOCATION


TRAVEL DATE(S)


daryl.m.delap.mil@mail.mil


TRAVELER 


No.


This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.


SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE


PAYMENT 
BY CHECK


PAYMENT 
IN-KIND


EVENT DESCRIPTION & 
EVENT SPONSOR


EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:


BENEFIT SOURCE


Asia Pacific Forum 
Pacific Rim Foundation 


3


LOCATION


TRAVEL DATE(S)


BENEFIT 
DESCRIPTION


TOTAL 
AMOUNT


U.S. Army
NETCOM


NEGATIVE 
REPORT


LOCATION AND 
TRAVEL DATE(S) 


[MM/DD/YYYY-
MM/DD/YYYY]


x


REPORTING 
PERIOD: 


OCTOBER 1, 
2018- MARCH 


31, 2019


REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 


30, 2019





		Instruction Sheet

		Agency Acronym

		RENAME BLANK FORM



